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Cursor style

The painting cursor is usually a small crosshair. There are three kinds of
crosshair you can use. The standard one is called the inverse cursor, which
means that the cursor will always be the inverse color from whatever color is
under it. This is usually fine, but you may be using colors that make it hard to
see the cursor. If you press the ‘=" key, the cursor will change to a white
cursor. If you press ‘=" again, you will get a black cursor. One more ‘=’ gets
you back to the inverse cursor.

Cursor visibility

You may want to hide the crosshair cursor sometimes, as when working with
small brushes in tight areas where a cursor might interfere with your view.
You can toggle the cursor on/off by pressing the ‘-’ key.

Brush tracking mode

The brush tracking mode is normally set to ‘color’ mode. This means that as
you move the brush around in the canvas, the brush will appear in the current
color or pattern. You can set the brush tracking mode to inverse by pressing
Apple-’=’. Press Apple-’=" again to return to color mode. The brush tracking
mode only applies to the regular brushes. The custom brush will always
appear in its true colors.

Screen crosshair

Sometimes it is helpful to have horizontal and vertical lines on the screen to
help line up what you’re about to paint with what you’ve already painted.
You can toggle the screen crosshair on/off by pressing Apple-‘-’.

Horizontal and vertical constraints

You can force various painting tools to operate in only a horizontal direction
or only a vertical direction. This is helpful for drawing straight horizontal or
vertical lines, or to help guide the eraser, etc. To force horizontal motion only,
hold down the option key while you click and drag the mouse. To force verti-
cal motion only, hold down the shift key while you click and drag.

Copyright
ImageMaster:Basic Paint is copyrighted by JADA Graphics, Inc. The disk
is not copy protected. Y ou may make one backup copy of the disk. You may
not copy the manual. You may not distribute copies of the software to any
person(s) or institution(s). This product is intended for use by the original
purchaser on one computer only. Any violation of these restrictions is a viola-
tion of United States copyright law, and is hereby expressly forbidden.

Service
If you need help with ImageMaster:Basic Paint , or to place orders for other
JADA Graphics products, call or write to:
JADA Graphics, Inc.
7615 S. 48th St.
Omaha, NE 68157

800-634-4552
Monday-Friday
9:00 a.m. to 5:00 p.m. (CST)

Credits

ImageMaster:Basic Paint was designed and programmed by Larry Jackson.
The manual was written by Larry Jackson.

Box design and artwork are by Larry B. Simpson.

“Moon” was painted by Cherry Simpson.

© 1992 JADA Graphics, Inc.
ImageMaster:Basic Paint is a trademark of JADA Graphics, Inc.

Apple, GS/OS, IIGS, ImageWriter, and the Apple logo are trademarks of
Apple Computer, Inc.



Warranty Information

Ninety-Day Warranty

JADA Graphics warrants, for a period of ninety (90) days from the date of
purchase, that ImageMaster:Basic Paint will operate as described in this
user's manual, and that the program is free of substantial errors or defects that
would significantly interfere with such operation. If you should find a serious
defect in the program, you may contact JADA Graphics at the address shown
under the section "Service" on the previous page. Depending on the particular
problem, JADA Graphics will either replace your copy of the program with a
corrected version, or will refund your purchase price (within the warranty
period only). For this warranty to take effect, you must send in the warranty
registration form within 10 days of the original purchase.

Disk Replacement

If the supplied program disk becomes defective during normal use within the
warranty period, JADA Graphics will provide a replacement disk. Contact
JADA Graphics for specific details on returning damaged disks. If the
program disk becomes damaged after the warranty period has expired, you
can obtain a replacement disk for a small handling fee. Contact JADA
Graphics for details.

Limitations

This product is warranted to the original purchaser only. There are no other
warranties, expressed or implied, except as stated above. This warranty gives
you specific legal rights, and you may also have other rights which vary from
state to state.

Miscellaneous Features

There are several features that are useful, but have no menu or dialog asso-
ciated with them. They are all accessed with special keys, and most are
usable at any time.

Border color

The screen border color can be set with the Control Panel desk accessory, but
this does not allow you to see your painting at the same time. You can set the
border color from within ImageMaster:Basic Paint at any time while you
are working on your painting, or while working with colors in the paint selec-
tor. There are only 16 colors possible for the border, and all are preset in the
hardware. You can step up in the border color list by pressing the ‘B’ key, or
step down by pressing ‘b’. The border color is saved with your painting, so it
will be set automatically the next time you load palettes or a painting.

Color pick

The Color Pick tool lets you select colors directly from your painting. This is
useful if you have several similar colors in your palette. If you want to know
exactly which color was used to paint a particular area of your image, the
color pick tool will tell you. Just press the ‘control” key to activate the color
pick cursor. As you move the cursor over your painting, every pixel that the
cursor passes over will be shown magnified in the cursor display rectangle.
When you are over the pixel you want, click the mouse and that color will
become the current painting color.

Pure color picker Dither color picker

Since IMBP works with both pure and dithered colors, there are separate
color pick cursors for each. Pressing the ‘control’ key gives you the pure
color pick cursor. To get the dither pick cursor, press the ‘control’ and ‘apple’
keys at the same time. If you use the dither picker, the dithered color you
choose may not be in the working palette. This is fine. You just won’t see any
color marked in the palette. All of the colors will be in the full palette, so if it
is turned on you will see the chosen color with a marker around it.
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Misc menu

The Misc menu contains items that don’t easily fit under other headings. They
don’t have anything in common with each other, and they don’t have much, if
anything, in common with any other menu items from other menus.

| @ File Edit Color Options
Text... aGT
Brush Size... &B
Copuycl —> c2...

Text...

The Text item presents a dialog that lets you set the font, style, and size of the
text chars that you type. There are many font families built in to the system
software. If you have purchased other fonts, you should be able to use them
with ImageMaster:Basic Paint if you can install them in the system proper-
ly. See the instructions that came with your font to install it.

Brush Size... ~

The Brush Size dialog lets you adjust the size of paint brushes, the eraser tool,
and the airbrush tool. It gives you a wide variety of sizes and shapes with
which to paint. The brush size dialog pops up automatically every time you

5 | click on a new brush shape, or when you

Width : 30 select the eraser tool or the airbrush tool. To
Height: 26

adjust the brush size, just click the mouse
anywhere in the brush display rectangle and
move the mouse around until you are satis-
fied with the size and shape of the brush.
The size (in pixels) is shown above the
display rectangle as you make the adjust-
ment. Click the OK button to quit.

Copy cl -> c2...
The Copy canvas item will copy the current canvas to the other canvas. If the

current canvas is c1, the menu will read “Copy cl ->¢2...”, else it will read
“Copy ¢2 =>cl...”, so that it always indicates the direction of copy. The copy
can’t be undone, so if there is anything on the unseen canvas that you want to
keep, you must first save it to disk.
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Triangles..........ccccoovviviiiiiiiiiniiiiiiiiininn, 10 To set the patterns which will be available in the working palette, just drag

Polygons......oueeeeeeiiiiiiiiiiii i 11 the patterns you want from the Full Pattern Palette tothe Active
Rectangles..........ccccceuieeeseeasaiaseesannn, 11 Patterns list.
Za.lgt P;;:Cher """"""""""""""""""""" i; To copy colors within the Full Pattern Palette, option-click to drag a
L 0V ) 1 > marquee around the patterns you want to copy, then drag the marquee to
=) 4 ST wherever you want it. Click the mouse when you are satisfied with the new
Y - 11 Y S 13 position, or press ‘esc’ 1o stop the marquee without copying. If you want to
Capture........cccouvnviniriiiiiiiiiiiiiiiiiia 13 copy a single pattern, just click on it and drag it to the new position.
Hand........ccoovvmmniiiiii i, 1
Magnify.....cccoueneeieieiiiiiieiieiaa 14
gzz\;as Selector.....couuviieiiiiiiiiiiiiiiiiiiain, i: Options menu
T@Sterrrerrreeeeoonsonsomssesnesnsssnosrsornsreeeees 16 The Options menu lets you set the on or off condition of various features.
When one of these features is on, it will have a check mark to the left of the
System Menu................. sssssasassscancasssnnassnssasanas 18 corrf:sp(?ndmg ment }tem. To‘tumone: thhefeamres on or off, just select it,
and it will change to its opposite condition.
Apple menu 18 - - -
PP About ImageMaster 18 | File Edit Color Misc |
.......................... Full Canvas &F
Control Panel.................c.ccccoueen..... 18 Coordinates d&ﬂl
File menu 18
New Canvas........ccccocvveiviiiiuiiniinn.... 19 Full Canvas
Load P’_ CLUME..oiiiiii 19 The Full Canvas item will hide all of the menus so that you can work on your
Save Picture....................c.ocoee. 20 painting on the full screen. It will also show the menus when you are finished
Load Palettes................................. 20 working on the full canvas. You can press the space bar to accomplish the
Save Palettes..............cccoeeeueeen... 20 same effect, except when you are using the Text tool. When using the Text
Load Patterns..........ccccceevuvuvnnnnnn.n... 20 tool, you must either select the menu item (if the menu is visible), or press the
Save Patterns.........c.cccovvveeenannnnn.. 20 Apple-F combination.
4 1 21
(017 | S P 21 Coordinates
A - The Coordinates item will toggle a small information bar that will show the
Edit menu 21 current mouse coordinates as you move the cursor around in the canvas or
Undo......coovvviiiiiiiiiiiiieiiiiiiiian, 21 _ magnify window. The information bar will appear across the bottom of the
CUL oo 22 canvas or magnify window. Apple-A will toggle the coordinates on or off at
COPY e, 22 any time.
Paste......cccceveemeiniiiiiiniiiiiiiiiinnn., 22
(03T | 23
-] o O 23
Make Brush.........ccccocvvviveiiiiiiiianni... 24

-35-



Patterns..

The Patterns dialog lets you edit any of the 64 patterns, or load and save pat-
terns from any Apple IIGS paint file. The Load and Save buttons work the
same as the “Load Patterns...” and “Save Patterns...” menu items under the
File menu. The OK, Cancel, and Undo buttons work as usual. The Clear
button will set all 64 patterns to white(Apple-click on individual patterns to
clear them one at a time).

Patterns
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Full Pattern Palette Invert

To edit a pattern, click on any of the 64 patterns in the Full Pattern
Palette. Its pixel pattern will be shown in the edit box. To modify the
pattern, first choose a color from the pure color list. Then click on any pixel in
the edit box. The change will be shown immediately in the edit box and in the
original pattern.

If you want to change all of the pixels in the pattern to a single color, drag a
color from the pure colors to the all box. All pixels in the pattern will be set
to the new color. To invert the pattern colors, click in the invert box. To
change all pixels in the pattern of a given color to another color, drag the
original color from the pure colors to the Old color box. Then drag the new
color to the New color box. All occurrences of the old color in the pattern
will be replaced with the new color.
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Two Dimensional Gradient (2D)

The 2D gradient is a combination of the horizontal and vertical gradients.
There are no special adjustments for the 2D gradient. It uses the same settings
as the horizontal and vertical. Whenever you change a setting for one of those
gradients, the 2D gradient is automatically updated to match.

Angular Gradient

The Angular Gradient allows you to draw gradient fills oriented in any direc-
tion. You adjust the angle of the gradient with the arrow buttons in the angle
adjustment area. The angle number and the graphic representation of the
angle are updated in one degree increments. When the angle is at 0 degrees, it
is identical to the horizontal gradient. When the angle is at +/-90 degrees, it is
the same as the vertical gradient. However, the angular gradient is independ-
ent of other gradients, so it does not affect the horizontal, vertical, or 2D
gradients at any time.

Radial Gradient

The Radial Gradient has two styles: rectangular and oval. They work
identically except for the shape. Y ou can choose whichever you want with
the Style icons below the radial gradient display rectangle.

The name radial means that the gradient radiates outward from a focal point.
To set the focal point, first click on the focus icon. A crosshair will appear in
the display area. Click and hold the mouse button anywhere in the display
rectangle, and move the crosshair around to any position. When you release
the mouse button, the radial display rectangle will be updated using the new
focal point. Click in the focus icon to end focus adjustment.
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The Invert button will invert the colors in a selected list from the gradient
colors list(see Gradient Color List below). The Reverse button will swap
the order of colors in a selection from the gradient color list (see Gradient
Color List below).

Gradient Color List

The Gradient Color List is the list of colors that will be used for creating gra-
dient fills. There can be up to 32 colors in the list, and any of the 136 colors
from the full palette can be put in the gradient color list. To put colors in the
list, click on any color in the full palette and drag the color to the position you
want in the gradient color list. You can drag multiple colors at once by
holding the option key down while you drag a marquee frame around the
colors in the full palette that you want to copy. The colors you select will be
presented in a row bordered by a marquee, just above the gradient color list.
Drag this marquee to where you want it in the gradient color list and release
the mouse button. Click outside the marquee to complete the copy, or press
the escape key to cancel the copy. You can also copy colors from one location
in the gradient color list to another by using the same technique. Also, any
time that a range of colors has been selected for copying, the Invert and
Reverse buttons will become active. They will not be active except when 2 or
more colors have been selected for copying.

The brace that appears above the gradient color list indicates which section
of the list will actually be used for gradient fills. You can adjust the position
of the brace by clicking near either end of the brace and dragging that end left
or right to any position, then repeating for the other end of the brace. The only
constraints are that you can’t cross the brace ends over each other, and there
must be at least one color between the brace ends.

Horizontal Gradient

The Horizontal Gradient will use the colors in the gradient color list to draw a
graduated fill moving from left to right within the defined area. The degree of
blending of the various colors can be controlled by the slider below the hori-
zontal gradient display rectangle.

Vertical Gradient

The vertical gradient is identical to the horizontal, except that it is vertical. It
also has one additional feature. The direction of the color list can be reversed
for the vertical gradient by clicking on the arrow at the bottom of the vertical
gradient display rectangle. This allows for all possible combinations of verti-
cal and horizontal gradients (see “Two Dimensional” gradients below).
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General Information

NOTE

This user’s reference manual assumes that you have some familiarity with
using your Apple IIGS® computer, and that you understand how to use a
mouse to select menu items. We will provide short definitions the first time a
new term is used in the manual, but if you are uncomfortable with short defi-
nitions or have never used a mouse before, you should refer to the user’s
manuals that came with your computer.

System Requirements

ImageMaster:Basic Paint requires an Apple IIGS computer with 1 mega-
byte of RAM, one 3.5" disk drive, an RGB monitor, a mouse, and GS/OS®
5.0.4 or later. A hard disk is recommended.

User’s Reference Manual

This manual is designed to be used mainly as a reference. You can read it
from start to finish if you need to, but you will probably find that
ImageMaster:Basic Paint is very easy to use without the manual. If you
need help with some specific problem, it should be easy to find the answer in
this manual just by looking for the appropriate icon(small picture) in the table
of contents, or by finding the corresponding reference word in the index.

The Screen

ImageMaster:Basic Paint is designed to run in 320 mode only. This means
that the screen dimensions will be 320 pixels wide by 200 pixels(or lines) tall.
A pixel(picture element) is a single “spot” of color on the screen. When you
are using a brush size of 1 x 1, it is exactly 1 pixel in size. All of your images
will be exactly 320 pixels wide and 200 lines tall. Since the program is orient-
ed toward viewing on the screen, images are limited to one full screen in size.
This allows you to see your entire image at once.

ImageMaster: Basic Paint
Throughout this manual, the terms “ImageMaster:Basic Paint ” and “IMBP”
will both refer to this painting program, ImageMaster:Basic Paint .



Getting Started

Disk Backup

Before doing anything else, make a backup copy of your ImageMaster:Basic
Paint disk. If you need help making a backup, refer to your computer user's
manual. After making your backup, store the original disk in a safe place.
Always work from the backup disk. If you have a hard disk, you will not even
need the backup disk after you have finished installation.

Installation

If you have a hard disk, you can install ImageMaster:Basic Paint onto your
hard disk and run it from there. If you do not have a hard disk, skip this
section and go to the section “Running from a floppy disk”.

To install ImageMaster: Basic Paint on your hard disk:

1. Turn on your computer and hard disk. Just startup your computer
in the usual manner.

2. Decide where you want ImageMaster:Basic Paint to reside. The
installation program will prompt you for the full path name of the
folder in which to install.

3. Insert the ImageMaster:Basic Paint disk into the 3.5" disk drive.

4. Open the IMBP disk icon.

5. Double click on the InstallHD icon to run the install program.

Or, if you prefer, you can just drag the IMBP and IMBPdata icons
to the desired destination folder. The IMBP program and
IMBPdata folder must both reside in the same host folder.

6. After installation is complete, close the IMBP disk and put the

disk away in a safe place.

Running From a Floppy Disk

If you are running ImageMaster:Basic Paint from a floppy disk, just open
the disk icon and double click on the IMBP program icon. After IMBP has
finished loading (the cursor will change from a watch to the arrow when
loading has finished), you can remove the floppy disk from the drive. You
should not need it after loading has completed.

Running From a Hard Disk
If you are running ImageMaster:Basic Paint from a hard disk, just open the
folder containing IMBP and double click on the IMBP program icon.

-2

Gradients...

The Gradients menu item will let you set various parameters regarding how
color gradients (shading) are handled. The Gradients dialog lets you see each
type of gradient, and shows the effect of various settings on the gradients.

Graodients

(_0OK ) (Cancel)

{Clear J)({ Find ) (Updote)
Gavert W (Beverse ) Undo )
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Horizontal | Vertical Angular — Angle Radial — Style
Two Dimensional (2D) “— Gradient — Focus
Color List

Gradient Menu
The Ok and Cancel and Undo buttons work as usual. The Clear button will

set all of the colors in the gradient color list to white. The Find button will
tell you where in the full palette any color from the gradient color list is
located. To use the Find button, click on the button, then click on any color in
the gradient color list. A marquee will appear around that color in the full
palette. Click anywhere to stop the marquee.

The Update button will redraw all of the gradients in the dialog. This can be
a little slow, so updating all of the gradients only occurs when you click the
Update button. As you adjust parameters of a specific gradient type, only that
type will be updated automatically. Also, as you change the colors in the
gradient list, none of the gradients are updated automatically. You can update
specific gradients individually by clicking in that gradient’s display rectangle.
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indicators on the right of the selector palette. The r-g-b indicators show the
levels of red, green and blue in the current color. The current color is also
shown along with its reference number from the paint selector palette. The
color black is reference number 0, and white is number 4095. The numbers
are provided for your reference, and serve no other purpose.

Selected Color ' Current Color
Step Adjusters Gray Levels

bl e Bl e b B P e R e L

<
AL

e
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Paint Selector Palette Gray center

When you have the cursor positioned over the color you want from the paint
selector palette, click the mouse and that color will become the selected
color. Its color, color number, and r-g-b values will be displayed in the
Selected Color indicator. It will also be copied to the pure color palette in the
position that is currently marked. You can change the pure color marker by
clicking on any color in the pure color palette.

You can use the r-g-b indicators to adjust the selected color. If you want to
make the color darker or lighter, click on one of the Step Adjusters to
adjust the r-g-b values up or down by 1 gray level per step. If you want to
adjust the red, green, or blue values separately, just click in one of the indica-
tor bars and the value of that color (red, green, or blue) will change as you
move the mouse left and right. The resulting color and color number will be
updated as you adjust the bar. When you are satisfied with the color, release
the mouse button.

Painting Environment

The Painting environment consists of three main parts; the system menu bar,
the canvas, and tool palette (a combination of painting tools and colors).
Below is a picture of the painting environment in its normal appearance. The
system menu bar is across the top of the screen. Each of the main menu
options will be discussed in detail in the “System Menu” chapter. The canvas
appears in the middle of the screen. This is where you will paint your pictures
using the tools and colors shown in the tool palette. There are more colors
and patterns than can be shown on the screen at once. See the chapters
“Colors and Patterns” and “Painting Tools” for more information.
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Only part of the canvas is visible whenever any menus or palettes are active.
To see the full canvas, use the “Full Canvas” option under the Options menu.
You can move the canvas around to see different parts of it by using the hand

tool in the tool menu. See the sections “Full Canvas” and “Hand” for more
details.

At times, the painting environment will look different from this, as you acti-
vate various features and menus. The same three general sections are almost
always present: a system menu bar, some portion of the canvas, and the tool
palette, plus additional menus and palettes if they’re active.




Colors and Patterns

Full Palette

ImageMaster:Basic Paint has a palette of 136 colors. The palette
shown here is called the Full Palette. Sixteen of the colors are
“pure”(along the hypotenuse), and 120 are “dithered”. Pure
colors are made of just one color. This is the normal kind of
color on the Apple IIGS computer. Dithered colors are
combinations of two pure colors, alternating every other
pixel, as in a checkerboard. When painting your pic-
tures, all of the tools treat the pure and dithered
colors alike, so that you have an effective
palette of 136 colors. No distinction is made
between pure and dithered colors in the
IMBP program, and in general no dis-
tinction will be made in this
590 85 85 8 manual. Any reference to painting
colors means any of the 136 pure and dithered colors. See the sections “Full
Palette” and “Paint Selector...” for more information on colors.
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Pattern Palette
ImageMaster:Basic Paint has 64 pat-
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Apple IIGS paint file, even those created
by other paint programs. All of the painting tools work with patterns exactly
as they do with colors. Just select the pattern you want to paint with, and
proceed with painting as usual. See “Patterns...” under the “Edit menu”
section for more information.
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To select any of the 64 palettes to be the current palette, just click in the box
to the right of the palette number. A small black dot indicates which palette is
being used as the current palette. To set any of the palettes to the standard
palette, click on the Std Pal button and then click on the desired palette. To
copy one palette to another, click on the palette you wish to copy and drag
the marquee rectangle to the palette you wish to change. When you release
the mouse button, the colors will be copied to the new palette. While you are
dragging the marquee, the palette list will automatically scroll if you move
the mouse past the top or bottom edge of the palette list. Click on the OK or
Cancel buttons when you are finished viewing the palettes.

Paint Selector Palette

The paint selector palette is where you will choose the colors for your pure
color and full palettes. There are two methods for selecting a color. You can
simply point to the color in the selector palette, or you can use the r-g-b indi-
cators to adjust the color values to whatever you like (see below).

To select a color from the paint selector palette, you should first choose the
gray level. The gray level slider above the palette covers 16 steps for 16
gray levels. There are a fixed number of colors available at each gray level.
At the white level (far right on the slider, level #15) are the most colors(721).
At the black level (far left on the slider, level #0) there is only one color,
black. As you move from the black to the white levels, there are more colors
at each higher level. The color in the center of the paint selector palette
always matches the current gray level. You can set the gray level by using the
mouse on the gray level slider, or by pressing the left or right arrow keys.

After setting the gray level, move the cursor into the paint selector palette.
The color that the cursor is currently pointing to will be shown in the r-g-b
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The OK, Cancel, and Undo buttons perform their normal functions. The
UnTest button is related to the Test button (see below). The Load and
Save buttons are equivalent to the File menu items “Load Palettes...” and
“Save Palettes...” (see those sections for operation details).

The Spread button allows you to create a smooth color transition between
any two pure colors. To use the Spread function, click on any color in the
pure color palette. Then click on any other color in the pure palette.
ImageMaster:Basic Paint will calculate which colors should appear in
between and make the appropriate changes. The full palette is also updated to
show the new dithered colors that are automatically created from the new
pure colors.

The Find button allows you to locate any pure color’s position in the paint
selection palette. Finding the location of any pure color in a list of 4096
colors would be very difficult to do by hand. ImageMaster:Basic Paint
makes it easy to find any pure color. First, click on the Find button. Then
click on any other color on the screen. IMBP will search the list of 4096 pure
colors and then highlight the location of that color with a small marquee
around the color. To stop the marquee, just click anywhere.

The Test button allows you to try out the colors in the full palette in a tem-
porary painting window. Click on the Test button to open the test window.

== 0K )

Hh (UnTest)

While the Test window is open, you can select any color in the full palette for
test painting. The chosen color will show in the current color box over the full
palette. The brush used for test painting is a small rectangular brush. Just
move into the test window and start painting. To clear the test window, click
in the X box at the lower left of the window. When you are finished testing,
click in the UnTest button to restore the Paint Selector menu buttons.

The Palettes button will display a dialog showing all of the 64 palettes
supplied by ImageMaster:Basic Paint. Y ou can select any of these palettes
to use for your painting, and you can change the colors in any palette to any
colors you like.
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Working Palette

The palette of painting colors and patterns that normally appears on the
screen is called the working palette. It contains the sixteen pure colors on the
left, 32 dithered colors on the right, and 13 patterns below the colors. On the
far left is the current color/pattern selection.

Top Dithers /— Bottom Dithers

Current Pure Dithered
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L Patterns
Background
—— Color / Pattern
——— Dither Reverser / Pattern Inverter

Dither Components

Pure Colors

There are 16 pure colors in the pure palette. The colors are arranged so that
you can easily see the palette compliment for each color. The palette compli-
ment is the color chosen whenever you invert the colors in a captured area.
The palette compliment for each pure color is the pure color directly above or
below it in the palette. The pure colors can be changed from the 16 standard
colors that you see when the program starts. See the section “Paint Selector..."
for details on color editing.

Dithered Colors

There are two rows of dithered colors in the working palette. Each row con-
tains 16 colors selected from the full palette. Any of the 136 colors can be
copied from the full palette to the dithered colors in the working palette. See
the section "Full Palette” for instructions on copying colors.

To the left of each dithered color row is a small rectangular box(Top and
Bottom Dithers color indicators). When there is a color in the box, it means
that the dithers to the right all contain that pure color. When there are black
stripes in the box, it means that the dithers do not all have a common pure
color. You can set the dithers in either row so that they all contain a given
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pure color by clicking on one of the pure colors and dragging it to either the
top dithers box or the bottom dithers box. The dithers to the right will
automatically change so that they all contain the indicated pure color. This
allows you to see all of the dithers for a given pure color.

Work Patterns

Below the pure and dithered colors are the patterns. The working palette
contains 13 patterns taken from the 64 total patterns available with IMBP.
Any of the 64 patterns can be copied to the working palette. See the section
"Patterns..." for more information.

Current Color

On the far left of the working palette is the current color indicator. On the
lower half is the area indicating the currently selected color or pattern. If the
color or pattern is in the working palette, it will also be marked with a white
rectangle around the color or pattern. When the full palette is showing, a
color can be selected that is not in the working palette. It will be shown in the
current color box, and will be marked in the full palette, but will not be
marked in the working palette.

Background Color

The background color is shown in the area around the current color. The
background color is the color that is used by the eraser tool, by the "New"
menu item when clearing the screen, and by the capture tools when moving
and clearing captured areas. The background color can be set by Apple-
clicking on any color in the working or full palettes (hold the Apple key
down while clicking on the color).

Dither Reverser / Pattern Inverter

Above the current color box are the reverser/inverter arrow and dithered color
components. When the current color is a pure color, both of the dither com-
ponents will be the same color. When the current color is a dithered color, the
two pure colors used to form the dither will be shown to the left and right of
the arrow. Clicking on the arrow will reverse the two pure colors in the
dither. This is useful when overlapping two or more dithered colors in your
painting. Overlapping dithers will sometimes produce horizontal and vertical
stripes. Reversing the dither can sometimes prevent the striping.

When the current color is a pattern, the dither components will show as black

and white. Clicking on the inverter arrow will invert all of the colors in the
pattern (all colors are swapped with their palette compliments).
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Paint Selector...

The Paint Selector is the utility that allows you to edit your color palette and
select 16 pure painting colors from any of ImageMaster:Basic Paint’s 4096
built in pure colors. The paint selection palette is laid out in a hexagonal
shape. The grays are in the center of the hexagon, with the primary colors
(red, green, and blue) and the secondary colors (cyan, magenta, and yellow)
at the comers of the hexagon. In between are all of the various combinations
of the primary and secondary colors. This arrangement allows you to see all
of the possible colors before selecting them, and it illustrates color theory and
how the primary colors combine to form all other colors. Each of the features
of the paint selector will be discussed in detail below.
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Paint Selector Menu

Several paint selector functions are accessible through buttons at the top of
the screen. The full and pure palettes are also shown on the left and bottom of
the menu. As you manipulate the pure colors in the pure color palette, the full
palette will show all of the changes in the corresponding dithered colors. The
menu area also doubles as a test painting area (see below).
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Fill Type...

The Fill Type item lets you set the type of filling that will be used when paint-
ing with filled shapes, text, and the paint pitcher tool. To select one of the
eight fill types, click in the radio button to the left of the desired item. Or, to
select a fill type without using this dialog, just press Apple-1 for
Color/Pattern, Apple-2 for Brush, and so on to Apple-8 for Snow fill, any
time the canvas is active.

Fill Tupe
O[Jcolor/Pattern

Gradients: @Snow
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The Color/Pattern fill selection is the normal choice. This includes all 136
colors from the full palette and the 64 patterns from the pattern palette.

The Brush fill selection is for the custom brush. After you have created a
custom brush (see “Make Brush” in the “Edit menu” section), you can use it
like any of the colors or patterns for filling areas.

The Gradient fill selections offer a variety of ways to fill an area with gradu-
ated shading. See the “Gradients...” section for descriptions of each type of
gradient fill.

The Snow fill selection will allow you to fill an area with a ‘snowy’ effect.
You can include any of the 16 pure colors in the snow. Just click on the colors
in the pure color palette to include them, or click a second time to exclude
them. Apple-click to include all 16 colors, or option-click to use only black.
There must be at least one snow color on at all times. If there is only one
color chosen and you wish to deselect it, you must first select another color,
then click on the first color to turn it off. You can adjust the amount of snow
using the Snowfall slider.
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Painting Tools

Below the working palette of colors and patterns is the brush and tool palette.
On the left are the available brushes, with the painting tools to the right. All
tools will work on the regular canvas (see the tool ‘c1’, “Canvas selector”, for
canvas descriptions) and in the magnified canvas (see the “Magnify” tool
description). In addition to actual painting tools, there are tools for editing
parts of your painting (see the “Capture” tools), moving the canvas around on
the screen (see the “Hand” tool), and canceling painting operations before
they become permanent (see the “Undo” and “Test” tools).
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Brushes Painting Tools

Brushes

There are 4 basic brush styles and a custom brush facility. The basic brush
styles are all adjustable, giving a wide variety of sizes and shapes. Each time

you select a new brush by clicking onit, a
gl } Basic Brushes brush size dialog appears. See the section

Ny i “Brush Size...” for details. The rectangular
} Custom Brush  20d oval brushes are simple to use. When

prrmmy

glliﬁiiiil! you click on either of these brushes, the brush

size dialog appears with the appropriate shape of brush in the adjustment
window. You can adjust these to any dimensions from 1 pixel by 1 pixel to 64
pixels wide by 50 pixels high. You can also change the brush style while the
size dialog is active. Just click on the brush style you want and it will appear
in the adjustment window.

The diagonal brush works a little differently. The diagonal brush is always
a 1 pixel by 1 pixel diagonal line. The size adjustment dialog works the same
way as for rectangular and oval brushes, but what you are adjusting is the
angle of the diagonal brush. If you click on the diagonal brush icon a second
time, it will change to a diagonal that is rotated 90 degrees from the original
diagonal. Subsequent clicking toggles between these two diagonals.



The bristle brush (represented by the dotted pattern) will give you an
effect something like a regular paint brush. When you click on the bristle
brush icon, the size dialog will automatically begin generating random pixels
within the current brush dimensions, and will continue generating pixels until
you release the mouse button. This allows you to generate a wide variety of
bristle brush styles, all of which will be different. If you adjust the size of the
brush, the pixel generation will also occur as long as you hold the mouse
button. It is sometimes easier to set the size first by using the rectangular
brush, and then click on the bristle brush icon to generate the pixels that will
be contained in the brush.

The custom brush is inactive until you capture a section of your picture
with one of the capture tools, and select ‘Make Brush’ from the Edit menu.
After creating a custom brush, you can select it at any time by clicking on
the custom brush icon. There is no size adjustment for the custom brush. It
will always be the exact size and shape that you created with one of the
capture tools.

Any brush can be used with any of the painting tools that use brushes. In
addition, the custom brush can be used with the painting tools that fill areas.
See the section “Fill Type...” for information on setting the pattern and color
for filling areas.

Freehand
The freehand tool lets you paint with complete freedom of motion.

= O After choosing the brush you want, click on the left or right half of
Tm= the freehand tool. The left half will produce a ‘broken’ freehand as
you paint, depending on how fast you move the mouse. The right half of the
icon will produce a ‘solid” freehand, regardless of how fast you move the
mouse. After selecting the style of freehand you want, just move the mouse
into the canvas, press the mouse button, and paint will be deposited wherever
you move the mouse, as long as you hold the button down. '

French Curve

The French curve tool lets you create smooth curves between a
Ln number of specified points. To use it, first click on the starting
point of the curve you want to paint. A ‘rubber band’ line will
follow the mouse until you click on the next point. Click on as many other
defining points as you like. Double-click on the last point to finish the point
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color is shown in the rectangle indicated by B:136. The ‘136’ is the color
number from the full palette. White is usually at the bottom, right corner of
the palette, which is number 136. The colors are numbered by columns start-
ing at the top of the leftmost column with black (#1). The bottom of the left
column is color #16, the top of column 2 is color #17, and so on to color #136
at the bottom, right of the palette.

The foreground color (the current painting color) is shown in the rectangle
labeled with F: followed by the foreground color number(#127 in the illustra-
tion). And the third color rectangle indicates the color that the mouse arrow is
pointing to as the arrow moves around in the full palette.
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You can select any color in the full palette for the foreground color by simply
clicking on it. To set the background color, Apple-click on any color. The
new choices will be shown in the background and foreground rectangles.

You may not want to keep the full palette window open all of the time, since
it takes up a large portion of the canvas area. You can copy some of the
colors from the full palette to the dithered section of the ‘working palette’
(see “Working Palette” in the “Colors and Patterns” chapter), and then turn
the full palette off. To copy colors from the full palette to the working palette,
hold down the option key as you click on any color, then drag the mouse
horizontally, vertically, or diagonally in the full palette to select the colors
you want to have in the working palette. When you release the mouse button,
the colors you have selected will appear in a marquee just above the working
palette. You can reverse the order of the colors if you Apple-click inside the
marquee. Use the mouse to drag the colors to the position you desire in the
dither section of the working palette. The colors will be placed in the working
palette as soon as you release the mouse button.
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Make Brush

The Make Brush command will copy the captured area into a buffer where it
can be used for a custom paint brush. After the Make Brush command has
completed, the captured area and the system clipboard remain unaffected, and
the marquee remains active. To stop the marquee, click outside the marquee
or press the escape (Cesc’) key. You can then use the custom brush just like
any other basic brush. See “Brushes” in the “Painting Tools” chapter for more
information on the custom brush.

L L W
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Before Make Brush After Make Brush New Custom Brush

Color menu
The color menu contains items to allow you to manipulate the color palettes,
pattern palette, set the fill color, and adjust the gradient fill parameters.

definitions. IMBP will then paint a smooth curve based on the number and
location of the defined points. To get the final curve to follow the defined
points more closely, just click more than once(slowly) on the points where
you want the curve to conform. The more times you click on a specific point,
the closer the curve will fit to that point.

Arc

The arc tool allows you to draw arcs with variable curves. Just
m click on one of the end points to start the arc. A rubber band line

will follow the mouse until you click again. This marks the other

end point of the arc. A rubber band arc will then follow the mouse movement
until you click again. When you are satisfied with the shape of the arc, click
the mouse and IMBP will use the current brush to draw the final curve.

Compass

The compass tool allows you to draw curves with a ‘fixed’ radius,
(} just as you would with a mechanical compass. With the compass
tool, a fixed radius means the radius for a fixed size oval. The

[@ File Edit RROLNE Options Misc
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Full Palette

The Full Palette item will turn the full color palette window on or off. When
the full palette is on, there will be a check mark beside the Full Palette menu
item. When the full palette is off, there will be no check mark. Apple-P will

also toggle the full palette.

The full palette window has four sections of interest. The full palette is
described in the chapter “Colors and Patterns”. In general, the full palette will
show all 136 of ImageMaster:Basic Paint’s colors. You can then select any
of them for painting.

The other three areas of interest are the indicators for the background color,
the foreground color, and the current follow color. The current background

224 .

actual radius length will vary as it moves around inside the oval.
Click on the center point of the oval(and hold the button down) to start the
compass tool. A rubber band oval will follow the mouse movements until you
release the button. After a brief pause for IMBP to do some calculations, you
will see the oval with a radius line and the current brush at the end of the
radius line. The radius line and brush will follow the mouse as you move
around, but nothing will be drawn until you click the mouse. To paint along
the oval curve, click and hold the mouse as you move it. You can paint as
many separate curve sections as you like. The compass tool will remain
active until you click in the OK box that appears on the canvas.

Line

The line tool lets you draw straight lines in any direction. Click on
/ one of the endpoints of the line to start drawing. A rubber band line

will follow the mouse as long as you hold the mouse button down.
Release the button when you are satisfied with the line, and IMBP will use
the current brush to paint the final line.

Polyline

The polyline tool allows you to draw a sequence of connected
\/\ straight lines. Click on the starting point of the first line and release

the button. A rubber band line will follow the mouse until you click

again. Then IMBP will draw the first line using the current brush, and begin
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following the mouse with a second rubber band line with its starting point
connected to the end of the first line. Click the mouse to set the end of the
second line. Continue this process until you are satisfied with the polyline. To
stop the polyline tool, double-click on the end point of the last line, or press
the escape key.

Closed Freehand
The closed freehand tool works exactly like the freehand tool,
@ except that when you release the mouse, IMBP will draw a straight
line connecting the starting point with the ending point. The
framed fireehand tool will use the current brush to draw an outline
a of the area. The filled freehand tool will use a 1 pixel by 1 pixel
brush to draw the outline and will fill the final enclosed area with
the current fill type. See the section “Fill Type...” for information on setting
the pattern and color for filling areas.

Wedges
The framed wedge tool allows you to draw wedges of any size and
D shape. Click the mouse to set the corner point of the wedge. Then,
as long as you hold the button down, a rubber wedge will follow
the mouse movements. When you are satisfied with the size and
l shape of the wedge, release the button and IMBP will draw the
final wedge using the current brush. The filled wedge tool works
exactly like the framed wedge, and after the final wedge has been set, the
interior of the wedge is filled with the current fill pattern and color. See the
section “Fill Type...” for help on setting the pattern and color for filling areas.

Ovals

The oval tools allow you to draw ovals of any size and shape. Click
o the mouse button to set the starting corner of the oval (you can start
in any corner). Then hold down the button and move the mouse

around until you are satisfied with the oval. When you release the
. mouse, the framed oval tool will draw the oval using the current
brush. The filled oval tool will fill the oval with the current fill
type. See the section “Fill Type...” for information on setting the pattern and
color for filling areas.

Triangles
The triangle tools allow you to draw isosceles triangles of any size.

A Click the mouse button to set the apex point, then hold the button
down and move the mouse around until you are satisfied with the

-10-

arrow key, a copy of the area will be deposited at the current location. This
allows you to make many copies of the captured area.

Whenever the marquee is active, you can perform any of the cut, copy, invert,
clear, or make brush operations, even though you may have started out with a
paste operation.

Captured area ready for Pasting

Clear

The Clear command will replace the captured area with the current back-
ground color, but will not copy the area to the system clipboard. After the
clear command has been executed, the marquee remains active for further
manipulation of the captured area. The clipboard remains unaffected. The
keyboard shortcuts for Clear are the ‘clear’ and ‘delete’ keys.

Before Clear After Clear

Invert

The Invert command will change the color of each pixel in the captured area
by swapping the color with its palette compliment. See the section “Working
Palette” in the chapter “Colors and Patterns” for more information on color
compliments. After the invert command has completed, the marquee remains
active, and the system clipboard is unaffected. If you choose Invert a second
time, the captured area will return to its original colors.

e e e = = .
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Cut

The Cut menu item will be selectable only when you have used one of the
capture tools (see “Capture” in the “Painting Tools” chapter) to cutline an
area of your picture, or when a paste operation has just been initiated (see
below). When you have an area of your picture ‘captured’, the cut operation
will remove the captured area from the picture, replacing it with the current
background color, and will put the captured area into the system clipboard.
The clipboard is a temporary place (usually on disk) where various informa-
tion can be stored for later use by a paste operation.

e e e e = 4

Before Cut After Cut

Copy
The Copy command will copy the captured area to the system clipboard, like

the cut command, except that the copy command does not delete the captured
area from the picture. It just makes a copy of it. The capture marquee remains
active after a copy operation, so you can continue manipulating the area in

After you have done a cut or copy, you can then ‘paste’ the captured area
back into your picture at another location, or on the other canvas. If you quit
ImageMaster:Basic Paint and run another paint program, you can then paste
the captured area into a picture in that program.

When you initiate the paste operation, you will get the captured area with a
marquee around it centered in the canvas. You can then move the area around
the canvas with the mouse or with the arrow keys. If you hold down the
option key while clicking the mouse inside the area, or when pressing an
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triangle. When you release the mouse, the framed triangle tool
A will draw the triangle using the current brush. The filled triangle

tool will fill the triangle with the current fill type. See the section

“Fill Type...” for information on setting the pattern and color for filling areas.

Polygons

The polygon tools allow you to draw polygons of any shape and
a complexity. The drawing process is identical to the polyline tool,

and after you double click to end the last line, IMBP automatically

draws a straight line from the end of the last line to the beginning

of the first line. The framed polygon tool then draws the polygon

lines using the current brush and color. The filled polygon fills the
area inside the lines with the current fill type. See the section “Fill Type...”
for information on setting the pattern and color for filling areas.

Rectangles

Rectangles of any size and shape can be drawn with the rectangle
D tools. Click the mouse button to set the starting comer of the rec-
tangle (you can start in any corner). Then hold down the button and
move the mouse around until you are satisfied with the rectangle.
When you release the mouse, the framed rectangle tool will draw
the rectangle using the current brush. The filled rectangle tool will
fill the rectangle with the current fill type. See the section “Fill Type...” for
information on setting the pattern and color for filling areas.

Paint Pitcher

=, | The paint pitcher allows you to ‘pour’ paint into an area. The area
'! I you wish to cover with new paint must be a single pure color. The

I new color can be any fill type. See the section “Fill Type...” for
information on setting the pattern and color for filling areas. Just click the
mouse anywhere on the color area you wish to cover with new paint. IMBP
will then fill the area with the new color or pattern, working outward from the
starting point until it reaches either a different color from the starting point,
or the edge of the visible canvas. IMBP will not fill under the system or tool
menus. To fill those areas that are hidden by menus, just scroll the canvas
(see the “Hand” tool for scrolling information), or hide the menus (see the
section “Full Canvas”™).
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Airbrush

G The airbrush tool let’s you ‘spray’ paint on the canvas in several
F B ways. When you click on the airbrush icon, the size adjusting

dialog appears. You can adjust the dimensions of the spray area

using this dialog. You can also click on either the rectangle brush or the oval
brush in the brush tools, and the size adjustment dialog will display the appro-
priate shape. After you have finished setting the size and shape of the airbrush
spray area, click on the OK button. When you move the mouse into the
canvas, you will see the airbrush in the same size and shape that you set in the
dialog. Just click the mouse and IMBP will ‘spray’ paint within the airbrush
boundaries as long as you hold the button down. You can move the mouse as
you hold the button down, and the longer you stay in one spot, the more paint

will be deposited. Release the button when you are finished using the air-
brush.

Text

The text tool allows you to enter any text messages you like, in a
T variety of fonts, sizes, styles, and fill patterns. See the “Text... ”
section under the “Misc menu” for information on setting the font,
size, and style of text. To use the text tool, just click the mouse anywhere in
the canvas (usually close to where you want the finished text to appear). A
rectangle will appear. This is the text entry box, and it will extend from the
point where you clicked to the right edge of the visible canvas, and will be the
height of the current font. The blinking bar indicates the current character
position. Just type the characters you want. The characters will appear in one
of the pure colors (black by default). If you want to enter the text in a differ-
ent color, press the tab key to step to the next pure color, or the Apple-tab
combination to step to the previous pure color. You can only use the pure
colors while entering your text, but the final result will be painted in the
current fill type. If the current fill type is set to a color or pattern, you can also
change the final text color by clicking on one of the pure or dithered colors,
or one of the patterns. '

When you have finished typing, or when you reach the right edge of the
canvas, press the return key. You will then see your text surrounded by a
marquee frame. You can move the text around to any position in the canvas
by either dragging it with the mouse, or by using the arrow keys. The text will
move up, down, left, or right by one pixel each time you press one of the
arrow keys. This helps you achieve precise alignment of the text with other
parts of your painting. You can also change the color of the text while you
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Print...

The Print item will print the current canvas to your printer. Your system soft-
ware should have printer drivers for several Apple printers. You can select
which printer driver to use by using the Control Panel DA and choosing the
DC Printer option. If you have another kind of printer, refer to the installation
manual for your printer to find out how to install the printer driver. If you
have an ImageWriter®I printer, your picture will print in black and white
only. If you have an ImageWriter II printer, your picture will print in black
and white or in color, depending on the type of ribbon you have in the printer.
When printing starts, a small message box will be displayed on the screen. It
tells you to press Apple-period to stop printing. If you press Apple-period,
there will be a short delay while the printer finishes printing what it is
working on, then printing will stop.

Quit

When you are finished working with ImageMaster:Basic Paint, choose the
Quit menu item (or press Apple-Q). If you have not saved the current canvas,
a warning dialog will give you a chance to save your work before quitting.
Only the current canvas is checked before quitting. If you have done work on
the other canvas and have not saved it, it will be lost after quitting.

Edit menu
The Edit menu contains items that allow you to modify the contents of your
picture, undo painting operations, create custom paintbrushes, and perform
cut and paste operations. Most of the items are standard for all Apple IIGS
applications. The operation and effect of each item is described below.

| & File l:ﬂ' Color Options Misc
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Clear

Invert I
Make Brush &M

Undo

The Undo item lets you try out a painting tool or editing operation and restore
your painting to its original appearance if you don’t like the change. See the
“Undo” section in the “Painting Tools” chapter for more information.
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Save Picture...

Save Picture will save the current canvas to disk. It also saves the current
color palettes and patterns with the picture. The Save Picture dialog works the
same as the Load Picture dialog, except that you have to enter a file name for
the picture. If the name you enter already exists on the disk, you will be asked
if you want to replace the existing one or not. If you choose replace, the exist-
ing file will be erased, and a new file will be created with the specified name
and containing your picture from the current canvas. If you choose to not
replace the existing file, you will have to enter a new file name for your
current picture. The keyboard shortcut for Save Picture is Apple-S.

Load Palettes...

Load palettes will aliow you to retrieve up to 64 palettes from any Apple
IIGS paint file. Paint files from other programs may have fewer then 64 pal-
ettes. IMBP will load as many palettes as it can find into the current palettes
list. After loading palettes, you may need to go to the palette selection dialog
to indicate to IMBP which of the palettes you wish to make the active palette.
The screen border color is also loaded with the palettes, and it will change to
the new color as soon as loading has finished. See the chapter “Colors and
Patterns” and the section “Paint Selector...” for more information.

Save Palettes...

Save Palettes will save all 64 palettes to disk. The palettes will be saved in a
standard file format that other paint programs can read. If another program
allows you to load palettes, it should be able to load some(probably just the
first 16) of the 64 palettes from IMBP. The current screen border color is also
saved with the palettes. See the section “Border Color” for details on settin
the screen border color. '

Load Patterns...

Save Patterns...

Loading and Saving patterns works just as it does for palettes. There are 64
patterns in the IMBP pattern list. All 64 patterns are saved with each IMBP
picture and when saving the patterns in a separate file. When loading patterns,
IMBP loads as many as it can find in the specified file, up to 64 (other pro-
grams may save fewer than 64 patterns in their files). Neither of the canvases
is affected by loading new patterns, since color information is not stored in
the pattern file.
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move it (as described above). When you are satisfied with the position of the
text, press the return key or click the mouse outside the marquee. The text
will be painted in the current fill type, and a new text entry box will appear. If
you had pressed the return key, the box will appear directly below the previ-
ous text. If you had clicked the mouse, the box will appear where the mouse
clicked.

After you have entered one or more lines of text, you can duplicate the previ-
ous line by typing Apple-R when the text entry box is active. The previous
line’s text will replace whatever text is currently in the box. When you are
finished entering text, press Apple-period, or the escape key (esc), or click on
another tool or menu item. Be sure to press return after positioning your last
line of text, or it will be lost if you press escape to terminate text entry.

Eraser

The eraser tool works like a standard pencil eraser. If you don’t

C1%| tike something you've painted ' int-
) - / ¢ something you’ve painted, you can remove it from the paint
ing with the eraser. When you click on the eraser tool, the size
adjustment dialog appears. After you have adjusted the size of the eraser, just
position the eraser over the area you want to erase, press the mouse button
and hold it down while you move the mouse over the desired area. The
current background color will be deposited wherever you move the mouse.
Release the button when you are finished erasing.

Capture

The capture tools allow you to outline sections of your painting
that you would like to move, copy, clear, invert, or use for a
custom brush. All three tools work the same way after the capture
sa0a | area has been defined. The only differences are in how you define
<" < | the capture area. The rectangle capture tool works just like the
rectangle tool, except that you will see a dashed marquee instead of
=sa_ | the normal solid lines. The polygon capture tool works like the
=== | polygon tool, and the freehand capture tool works like the closed
freehand tool.

After you have defined a capture area, you can do several things with it. See
the section “Edit menu” for details on cut and paste operations. While the
marquee is active, you can move the captured area by dragging it with the
mouse, or by using the arrow keys. When you move the captured area, the
current background color will be deposited in the original area. If you want
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the original paint to remain unaltered, hold down the option key when you
click the mouse or press an arrow key. You can option-click or option-arrow
key at any position to place a copy at that location. When you are satisfied
with the new position of the captured area, just click the mouse outside the
marquee, or press Apple-period. If you press the escape key at any time, the
marquee area will be cleared and the original captured area will be restored.

Hand

The hand tool is used for moving the canvas around on the screen
@ whenever there are menus covering part of the canvas. After you
have selected the hand tool, just position the hand icon anywhere in
the canvas, click and hold the mouse button, and the whole canvas will move
around as you move the mouse. Release the mouse button when you are satis-
fied with the canvas position. You can also move the canvas by pressing the
arrow keys. If you are working on the full screen canvas, the hand and arrows
will have no effect. If you have moved the canvas around and would like to
get it back to its normal position, just Apple-click on the hand tool.

Magnify

The magnify tool is used to enlarge some portion of the image to
C): make it easier to work on small details of your painting. There are
10 levels of magnification to give you maximum control over the
amount of enlargement. When you click on the magnify tool icon, a rectangle
will follow the mouse as you move around in the canvas. The rectangle indi-
cates the area that will be magnified. To change the magnification level, press
the tab key to increase magnification, or press Apple-tab to decrease magnifi-
cation. The size of the rectangle will change accordingly. When you have the
rectangle positioned over the desired area of the canvas, click the mouse to
activate the magnify window (see below). You can also press the ‘M’ key
whenever the mouse is in the canvas, and the magnify window will be acti-
vated using the current magnification level and the current mouse position.

The Magnify Window '

When the magnify window is active, the screen will be divided into two main
sections. On the left will be the magnify window, and on the right will be the
unmagnified canvas. Only part of the full canvas will be visible, and the
magnified area will be centered in the canvas, if possible (see following
picture).

Under the magnify window will be the magnify menu. It contains level
markers for each of the 10 magnification levels. To change the level, use the
tab key (as described above), or click on one of the markers. To the right of
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which file to load, and to enter the name of the picture as you save it. These
dialogs are standard for all Apple IIGS applications. If you are unfamiliar
with file dialogs, refer to your Apple IIGS user’s manual.

@ N aAlE Edit Color Options Misc

Mew Conwvas [»1, ]
Load Picture... w11
Save Picture... af

Lood Palettes...
Sove Palettes...
Lood Patterns...
Sagve Patterns...
Print...

Quit (u]1]

New Canvas

The New Canvas selection will clear the current canvas and reset various
parameters for a new, clean canvas. You will need to choose New Canvas
whenever you have finished working on a picture, or whenever you want a
clean canvas. If you have not saved your work prior to choosing New
Canvas, a wamning dialog will appear to verify whether you wish to save your
current work before clearing the canvas. If you do not save your work before
clearing, it will be lost and can’t be recovered. New Canvas only affects the
current canvas, and leaves the other canvas alone(see the section “Canvas
Selector”). Notice the Apple-N on the right of the menu. Holding the Apple
key down while pressing the ‘N’ key will select New Canvas just as if you
had selected it from the File menu. This is a keyboard shortcut, and is usable
at any time. It is especially useful when painting on the full canvas and no
menus are visible.

Load Picture...

Load Picture lets you load pictures from disk into the current canvas. The
dialog box will let you move around to any folder on any disk. When you see
the picture you want to load, double click on its name, or click once on its
name and then click the Open button. The picture and its color palette and
patterns will be loaded. The picture will only affect the current canvas, but
the color palette will apply to both canvases. This will cause the colors in the
other canvas to change, if the newly loaded palette is different from the one
prior to loading. As with New Canvas, if you have not saved your current
work, a warning dialog will give you the opportunity to save your work
before loading a new picture. Also, you can press the Apple-O key combina-
tion to select Load Picture.
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System Menu

The system menu bar(also called the main menu) contains several items. Each
main menu item has several choices that appear when you click the mouse on
the main menu item. If you need help learning how to select menu items,
refer to the user’s guide that came with your Apple IIGS computer. Below is
a description of each main menu item and each of its choices.

Apple menu
The Apple menu appears on the far left of the main menu bar, and is repre-
sented by a small apple shaped icon. It contains one fixed menu choice,
“About ImageMaster...”, and other choices if there are any desk accessories
(DA’s) installed in your system. The most common desk accessory is the
“Control Panel”.

the level markers are the grid style markers. They indicate whether the
magnify window will have no grid lines, or black or white grid lines. To
change the grid lines, click on one of the markers, or press the ‘[" or ‘]’ keys.

File Edit Color Options Misec

About ImogeMaster... |
Control Panel |

About ImageMaster...

This menu item provides information about the ImageMaster:Basic Paint
program. After selecting this item, a dialog box will appear with some infor-
mation and an OK button. After you have read the information, click in the
OK button or press the return key, and the dialog box will disappear.

Control Panel

The Control Panel DA is a set of utilities that let you adjust or set various
features of your Apple IIGS computer, such as the screen border color, printer
type, and many others. This desk accessory is supplied with your system soft-
ware, not with ImageMaster:Basic Paint, so you may or may not see it in
the Apple menu. If you have other desk accessories installed in your system,
their names will also appear in the Apple menu.

File menu
The File menu is a standard menu item in most software for the Apple IIGS
computer. It contains several items to assist you with loading and saving data,
beginning a new picture, printing your picture, and quitting IMBP. All of the
load and save menu items will display a dialog box that allows you to select
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‘When painting in the magnify window, you can use any of the painting tools.
They all work exactly the same in the magnify window, except that every-
thing is enlarged. You can’t draw in the normal canvas when magnify is on.
If you move the cursor into the canvas, a rectangle will follow the cursor
motion, to allow you to select another area of the canvas to magnify. You can
also use the hand tool and arrow keys to scroll the canvas inside the magnify
window.

If you tumn on the full palette while the magnify window is active, you will
not be able to see the normal canvas because the full palette will use that
portion of the screen (see the section “Full Palette”), but you can still paint in
the magnify window as usual.

Canvas Selector

The canvas selector tool lets you toggle back and forth between 2
c 1 canvases. Each canvas can hold a full image, and you can use the 2
canvases in any way you like. ImageMaster: Basic Paint does not
care which one is currently visible. You paint the same way on either canvas.
You can save and load pictures for each canvas separately. The only con-
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straint is that the color palette will be the same for both canvases. This
enables you to use one canvas as a scratch pad and copy sections from one
canvas to the other without affecting the colors in the copied section. The
color palette that will be used is the one from the most recently loaded picture
or palette(or the default palette if no picture or palette has been loaded), plus
any changes you’ve made to the palette since loading.

The ‘c1’ tool icon indicates which canvas is currently visible. To change to
the other canvas, just click on the ‘c1’ tool and the other canvas will become
visible. The ‘c1’ will change to ‘c2’ and vice versa as you switch canvases.
You can also press the ‘1” or ‘2’ keys to select the canvas you want. This is
especially useful if you are painting on the full canvas. You can change can-
vases at any time(even when magnify is on). Also see the sections “New
Canvas”, “Copy ¢l ->¢2...”, “Load Picture...”, and “Save Picture...”.

Undo

The Undo tool allows you to ‘erase’ or ‘un-paint’ your last painting

UN action. After completi inti ion, i i
. pleting some painting action, if you click on the

oo Undo tool icon before starting another painting operation, the paint
you just put on the canvas will be removed. Once you start another painting
operation, all previous paint becomes permanent (until you paint over it or
erase it). Undo allows you to try out an idea before making it a permanent
part of your picture. If you click Undo twice, the paint that was undone gets
restored. This undoing and restoring allows you to compare your painting
with and without the changes you are trying out. You can also activate the
undo process by pressing the escape key(esc), Apple-Z, or by selecting Undo
from the Edit menu. See the “Test” tool section for more undo information.

Test

The test tool is similar to the undo tool, but works over a longer
I[ST time frame. When you click on the test tool icon, you enter a ‘test
mode’. This just means that IMBP will be keeping track of every-
thing you paint while the test mode is active. All tools work the same in test
mode, but you can’t switch canvases, load, save, or print pictures, and you
can’t copy one canvas to the other (see “Copy cl -> ¢2...”).

The undo tool works normally while test mode is on, but works a litde differ-
ently right after turning test mode off. After you have finished painting all
you want to with test mode on, click on the Test tool icon to turn test mode
off. Now, if you use the undo tool, everything you painted during test mode
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will be treated as a single painting operation and will all be undone or redone
as you click on the undo tool. As soon as you start another painting opera-
tion, undo will work as usual and just undo the last operation.

In general, the Test mode tool allows you to try out complex changes to your
painting before making them permanent. If you are not satisfied with the
result, undo will then restore your painting to the image you had before you
started test mode.
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